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Service Software

Phoenix
Phoenix is the new generation Service Software. It has been designed to meet the chal-
lenges in servicing modern cellular phone technology.

The Phoenix program has been built using component architecture. This means that the
actual program is small and most of the program's functionality is divided into dynami-
cally loaded modules (DLLs).

Supported Operating Systems
Windows 98, 2000, ME and NT 4.0 (SP4).

Hardware requirements for using Phoenix

Minimum:
Processor 233 MHz, RAM memory 64 MB, Disk space 50-100 MB.

Recommended for Windows 2000:
Processor 700 MHz, RAM memory 512 MB, Disk space 50-100 MB.

Introduction

This section briefly describes how to install the Phoenix software and includes some
basic information on how to use the program. For more detailed information, please refer
to Phoenix’'s Help -files. Each feature in Phoenix has its own Help function, which can
be activated while running the program.

Press the F1 key or the feature's Help-button to activate a Help -file.

Installing Phoenix

1. Download the latest release. Please contact your regional After Market Services point
for information on where to download the latest release.

Download and read the release notes, which have useful information on the software
Version you are using.

2. Download the latest data packages for the products you will be using.

3. Before you start installing the program, check that

- the dongle is attached to parallel port. Contact your supervisor in order to obtain a
suitable dongle.

- you have administrator rights (Windows 2000 or NT only). This is required in order
to be able to install Phoenix.

4. Install Phoenix by executing the Phoenix installation package and follow the instruc-
tions on the screen.
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Initially the setup files are extracted into the file system.
Note: If the setup files are already extracted (left in the file system from previous installa-
tion) “Overwrite Protection” dialog appears. Always click "Yes to All" to overwrite the exist-

ing setup files.

5. The installation checks that the latest supported dongle driver version is installed. The
dongle driver is installed if there is no previous installation of the dongle driver or if the
installed dongle driver is older than the latest supported version.

Note: If the dongle driver isinstalled during installation, you need to reboot your PC and
restart the installation after reboot.

Program files are stored under " C:\Program Files\Nokia\Phoenix" (default).

6. Install the data package by executing the installation package and follow the instruc-
tions on the screen.

The data packages will create product specific directories under the installation direc-
tory.

Data files are stored under " C:\Program Files\Nokia\Phoenix" (default).

Uninstalling Phoenix
If you need to remove Phoenix Service Software from your computer:

1. Make sure that the dongle is attached (unregistration).

2. Go to the Control Panel and select Add/Remove Programs.

3. Select NHM-10 RELEASE for uninstallation and click Add/Remove.
4. Click OK to remove the application

You may have to reboot your PC after uninstallation.

Note: If you have different product packages installed, the components are uninstalled only if
they are not included in other product packages.

Data Packages

Data Packages (DP) is a name for a helpful feature in the Phoenix software. This type of
feature provides a flexible way of distributing and installing Phoenix and its data files.

All product-specific data is separated from the program code and installed separately.
This means that the installation is performed in at least two steps.

Each product will have its own Data Package (DP). The FPS-8 flashing equipment also has
its own package.
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Starting a session

Concepts

In the Phoenix context, Product means the cellular phone attached to a PC. More specif-
ically, it is a particular type of phone.

Connection means the type of cable used to attach the phone to the port to which the
other end of the cable is attached.

Selecting a product

Many of Phoenix's features are product-specific. It is, therefore, mandatory to choose the
product you will be working on at the beginning of the session.

Select the menu item File - Choose Product. You will be presented with a list of available
products.

After the product selection, you will see an additional menu item on the main menu. If
you take a look at the available menu items, you will see that their number has
increased.

Selecting a connection

The connection defines the cable and the communications port that will be used when
connecting to the phone.

1. Active connections are listed in the toolbar's Connection pull-down menu. You should
make sure that the connection is correct before using the software. Change it, if neces-
sary.

In case the connection is the wrong, you need to create a new one.
2. Select Settings from the pull-down menu .

3. Select Add in the Connection List Dialog and in fill the relevant fields in the Connec-
tion setup dialog.

Phoenix environment

You can configure the program's main toolbar and the product or tool -specific options
to your liking.

You can control which toolbars are visible by selecting View and Toolbars from the pull-
down menu. The visible toolbars are marked with a check.

The rest of the options are product or tool -specific. The tool-specific options are set
using the associated toolbar.

Using components

When working with Phoenix, each task generally has its own component that will per-
form the task. The first thing, therefore, is to open the desired component.
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Opening a component means that you open a tool window within Phoenix. When this
window is opened, Phoenix also opens a toolbar for it and adds component-specific
menu items in the View menu.

Using profiles

A Profile is a useful feature in the software. Product, connection and currently open
components can be stored into a permanent storage (a disk file called profile, *.nmp) for
later retrieval.

Opening and saving profiles is done via menu commands found in the File menu. Select
Open Profile and Save Profile.

Since profiles are stored into a disk file with the user-defined name, there can be multi-
ple profiles for different repeated tasks.

SW update flashing setup

FPS-8 Flash setup

The following equipment is required for 3600 (NHM-10) AMS SW update, when con-
necting NHM-10 to PC with FPS-8:
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Item | Description Type Code

1 Docking station adapter MJF-31 (use with JBV-1) 0770478

1a Point of Sales flash loading adapter | FLA-48 0770582

2 Power cable PCS-1 0730012

3 Power cable FLC-2 0730185

4 Modular cable XCS-4 0730178

5 Flash prommer box sales pack FPS-8 0080321

6 Printer cable AXP-8, incl in FPS-8 sales pack

7 D9 - D9 cable AXS-4 , incl in FPS-8 sales pack | 0730090

8 Software protection key PKD-1 0750018

9 AC Charger, incl in FPS-8 sales pack 0680032

10 SRAM Module (2 pcs needed SF12 0080346 (Code includes

inside FPS-8) one SRAM module)

POS Flash concept

The following equipment is required for 3600 (NHM-10) AMS SW

salewhen connecting NHM-10 to PC with FLS-4:

update, at point of

Item | Description Type Code
1 Point of Sales flash loading adapter | FLA-48 0770582
2 Service cable XCS-1 0730218
3 FLS-4S sates pack for E & A FLS-4S 0080541
4 FLS-4S sates pack for APAC FLS-4S 0080542
5 FLS-4S sates pack for US FLS-4S 0080543
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Module Jig Flash concept

The following equipment is required for 3600 (NHM-10) AMS SW update when system
module is placed in the Module Jig MJS-51 and connected through a FPS-8 set-up:

Item | Description Type Code

1 Module Jig MJS-51 0770579

2 Power cable PCS-1 0730012

3 Modular cable XCS-4 0730178

4 Flash prommer box sales pack FPS-8 0080321

5 Printer cable AXP-8, incl in FPS-8 sales pack

6 D9 - D9 cable AXS-4 , incl in FPS-8 sales pack | 0730090

7 Software protection key PKD-1 0750018

8 AC Charger, incl in FPS-8 sales pack 0680032

9 SRAM Module (2 pes needed SF12 0080346 (Code includes

inside FPS-8) one SRAM module)

Note: All tunings except Zocus calibration can be done with JBV-1/MJF-31 concept by
using XRF12 RF cable.

NHM-10 Phoenix installation instructions

Now that cables have been connected, you must install NHM-10 version of Phoenix to
your PC.

. 4.13.005 is currently the newest available NHM-10 AMS Phoenix SW

NOTE! You must use 2003.17.3.12 Phoenix release in order to get
new SW into your Nokia 3600.
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Save the package to your hard disk and install it by doubleclicking it.

NOTE!It is recommended that you uninstall previous Phoenix package before installing the
new one. Do it as follows:

Click Start -> Settings -> Control Panel
Add/Remove Prog.

Phoenix NHM-10 release

Add/Remove

Reboot your computer after uninstallation

FPS-8 to PC connection Setup instructions
Establish connection between your PC and FPS-8. The procedure is as follows:

Start phoenix

Choose File -> Manage connections
Choose Add

Select mode, select Manual

As Media, select FPS-8

Port number, select the port where you have connected the serial cable of
FPS-8.

COMBOX_DEF_MEDIA, select FBUS
Click on Finish

Press Arrow up key so that FPS8 COM1 FBUS becomes the first on the
list.

Press Apply and close the window

The connection between PC and FPS-8 has now been configured.

FPS-8 activation

Follow the instructions inside FPS-8 sales pack to get FPS-8 activated.

Checking Application SW version inside FPS-8

When you have connection established to FPS-8 and FPS-8 has been activated, the first
thing to do is to check that you have correct application SW version inside FPS-8. Phoe-
nix SW can check that automatically. The procedure goes as follows:

Go to the partner web site and take newest AMS FPS-8 SW.

Instructions:

Issue:1 07/2003
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o Click AMS/Production version

o Click 2.10.000

o Take file flash_update_02_10_000.exe

o Save it to your hard drive to a place which you can remember

° Go to that directory and click on flash_update_02_10_000.exe

You will see the following note on your screen. Install files to the directory which instal-
lation program suggests to you.

Figure 1: InstallShield Wizard screen

InstallShield Wizard [ x|

Chooze Destination Location

Select folder where Setup will install files.

Setup will install Flazsh Update in the following folder.

Toinztall to thiz folder, click Mext. Toinstall to a different folder, click Browse and select

anather folder.
D estination Folder
’7E:\F‘mgram Filez\Mokia'Phoenix Browsze. . |
|retall Steld

Cancel

When the installation has been finished, FPS-8 files are located in that directory.
You can now start phoenix SW.

When phoenix SW has stared, do the following:

Click on flashing

Click on FPS-8/FPS-8C Maintenance

If SW inside FPS-8 prommer is too old, you get the following notification:

Figure 2: Prommer SW update screen

Prommer sw update E |

Mew version of prommer zoftware iz availablel
Do pou want to update?

Wersion 02.03.000

[ Do nat show this dialog agair

e | [ [a] |
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Click Yes and you see on the small scree as the Prommer goes to service mode (mode2 is
lit) SW goes into box, application SW , Secondary boot codes and algorithm codes are
updated.

There is no longer need to do anything special with NHM-10 specific Secondart boot
codes and algorithm codes.

Your PC and FPS-8 is now ready for NHM-10 SW update.
Reprogramming NHM-10

Connecting cables

Once you have the NHM-10 opened and the battery and SIM removed, attach it to the
FLA-48 adapter. Once connected to the FLA-48 the phone goes to local mode and the
screen will not show anything during SW update.

Proceed as follows:

. Connect XCS-4 cable from FLA-48 to FPS-8
. Connect FLC-2 cable from FPS-8 to FLA-48
. There is no need to press the phone power key. Phone has set itself automati-

cally to local mode and it is now ready for SW update.

Settings backup/restore

It is quicker to use MMC user data backup, which can be found at: Menu > extras >
memory > options > backup phone memory.

Start Phoenix SW by doubleclicking the Phoenix icon on your desktop.

o Now choose File -> Scan product. If phone is ok, you should see the SW version
in lower right-hand corner, e.g. V3.1

. If the scanning finds nothing, the phone is most likely in some strange mode.

Settings Backup:
o Click Product
o Click User settings
o Click All Settings

. Click Browse
o Choose from Directory C:\Program files\Nokia\Phoenix\Products\ file
Nhi8sett.ini

You will now see the following PC screen:
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Figure 3: All settings screen

—lo| x|
— Settingz configuration file
IE:\Program FilestMokiaWPhoenizhProductz\nhiSsett ini
— Settings — Settings selection—
Mame | Status | Type | - Check all |
S05 General gettings Mid, LUSER
305 Phanebook N USER pocheekn
S05 Meszaging Centre M LUSER Only Failed |
505 Phato dAlbum M A USER
S05 T Dictionary M LUSER Prod. Settingsl
S05 Ringing Tones M LUSER -
505 Operator Logos N4 USER User Settings |
SO5 Usger profile zettings M LUSER
SO5 wWhil Browser zettings M, USER __| .
— Operation:——
S0O5 wWhil Browser Bookmarks M LUSER
S05 Date & Time settings M, LUSER Save... |
505 GPRS settings M A USER -
505 Blugtoath settings N6 USER Ll
S05 Calendar # To-Dio list M USER Open Log |
S05 Calculatar settings M USER
505 Pinboard settings M USER
505 Motepad settings M, USER « Help |
| [»

Updating software
New SW package can be updated.

o Choose Flashing -> FPS-8 Flash -> Mark both log flashing and Manual Selec-
tion. Then Click on Flash.

. Now in Flash file selection window, choose the product code.

Select the correct file:
Now click on OK, and SW update starts.

You will see as the 18 MB package goes into FPS-8 (If transfer is very slow, it is recom-
mended that Parallel port is in ECP mode. Transfer in ECP mode is much faster).

If you do not know how to Change PC Parallel port mode from BIOS, contact your local
support.

Then Phoenix erases flash memories .

And finally you will see how SW package goes into phone (When SW update takes place,
Yellow Mode 1 led is blinking fast)

When SW update has ended yellow led stops blinking and you get a note in windows SW.
You will get instructions to turn the phone on. Do so and wait 15 seconds..
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Formatting user area

User area also neededs to be formatted in order to make sure that there is no user data
left in the phone.

Choose File -> Scan product. In the bottom of the Phoenix window you should see
V3.1, Date, NHM-10(c) NMP

Format User area the following way:

Click Product -> User area format. You will get a note warning you about loss of user
data. Click yes on that.

Phoenix shows Formatting user data area, Please wait screen for a while and gives you a
success note.

Restore settings
Settings can be restored from MMC or Phoenix.

Energy Management Calibration

Connections

NHM-10 phone must be connected to JBV-1 (Docking station) with MJF-31 (Docking
station adapter).

° Connect CA-5S (DC-DC cable) from JBV-1 into to phone charger connector
before powering up JBV-1.

. Power up JBV-1 from external power supply: 11-16 V DC. (Do not take power
from FPS-8 in calibration mode).

Phoenix Setup

o Start Phoenix.

o Select FBUS connection.

. Choose Main -> Choose product...

. Choose Maintenance -> Tuning -> Energy Management Calibration component.

Calibration
1) Mark all channels (ADC, Battery Size...except Battery temperature).
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Figure 4: Energy Management Calibration screen

'-_'E Energy Management Calibration ;Iglil

— Calbrated——— F'hu:une"‘vfalues —

ADC Offset [mv]
ADC Gan -
[0.0007 miAbit] Calibrate |
¥ Battery Size B 5| Gain [100 Ohm]

Save To Phone |

Read From Phon

SCAL Offzet [mi]
SCAL Gain

¥ Batteny Yoltage

[

Change Phone

¥ Charger Yoltage YCHAR Gain

Help

W Charge Curent ICHAR Gain

|
|
|
I iy Temmeratia BTEMP Gai |
|
|
|
|

Status: I

2) Press Calibrate button.

After successfull calibration Calibrated indication is shown.

3) Press Save To Phone to save tuning values into phone memory.
After successful saving Values written to phone is indicated.

4) Verify tuning values saving by pressing Read from Phone.

ZOCUS calibration

Zocus requires re-calibration only if the Zocus device itself is replaced, any of the com-
ponents on the sense input (R383, R384 and C386) or if the flash memory is corrupted.
Zocus does not require recalibration if the UEM device is replaced or if any of the other
energy management calibrations are recalibrated.

1 Place the PWB in the module jig.

2 Connect an ammeter across the ammeter + and ammeter - connections.

3 Set switch S2 to the calibration position.

4 Power up the module jig in local mode - the ammeter will indicate the local
mode current.

5 Connect the charger input to a power supply set to 8.4V and current limited to
500mA. Turn power supply on.

6 Open the Zocus EM window in Phoenix.

7 Click on “Close the Charge Switch".
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8 Adjust the current limit on the power supply until the ammeter reads 500mA
+5mA.
9 Type the measured current (read this from the ammeter) into the "Measured Cur-

rent” box. The value is negative and presented in Amps e.g. if you measure
502mA, then type -0.502. The reading should be to the nearest mA.

10 Click the “Calibrate” button.

n If you wish to check the calibrated value then do not choose to close the charge
switch. The calibrated current value will appear in the Zocus_Cal_Current win-
dow.

12 The calibration value appears in the box Zocus_New_Cal. To write this to the

phone click "Write".

JREIET

—&a0C Reading:
Log File: I Browse |
Samples: IE,_4 Interval [3]: IE,_E Cantinuaus [ Head
Battery Current: I—

r— Calibration:

Meazured Current [4): I Required_Gair: I Calitrate |
Zocuz_Old Cal: I Zocuz Mew Cal; I wirite |
Zocus_Uncal_Current: I Zocus_Cal_Curent I

Claze Charge Switch |

@ Far AkS jig calibration, set the meazured current ta [minus] -0,

Phoenix tuning

Connect the phone to a PC running the Phoenix Service Software.

Start Phoenix Service Software and open FBUS connection

Select File  Scan Product

Wait until phone information is shown in the lower right corner of the screen.

RF tuning after repairs

Different repairs require different tuning. In general it is necessary to determine in which
section the repair was done to select which tunings to perform. To determine if RF tuning
is necessary after repair it is important that the functionality of the repaired circuit is
understood well. It is recommended to perform complete RF tuning if RF is repaired.
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. In general repairs in the TX part will require "TX Power Level Tuning" and "TX 1Q
Tuning".

o In general repairs in the RX part or PLL part always require "RX Calibration”, "Rx

Band Filter Response Calibration”.
. If Mjoelner is changed all calibrations have to be done.

Other parts interfacing to TX, RX or PLL might require tuning, but common sense should
be used, e.g. if a component that has no influence on RF performance has been changed,
e.g. the microphone, on/off key, mechanical parts or similar, there is no need to do any RF
tuning.

RX Channel Select Filter Calibration

This calibration is calibrating the Base band filter inside Mjoelner. It is done by internally
measuring a prototype filter, for this reason the calibration is done once, not separately
in 2 bands.

Set operating mode to local mode

Select Maintenance Alt-M
Tuning T
RX Channel Select filter Calibration H

A window pops up:

Start tuning

Load Y alues From Phone?

Select Yes and the RX Channel Select Filter Calibration window pops up.
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The setup should now look like this:

T4 Phoenix [ _[O]
File Edit “iew Product Flashing Maintenance Toolz BD  Window Help

J = J Qonnections:lEDM j Settings... |

| Dpsrating mode: [Local =] _Bead | T Change with Rreset | Rw/TuChannet 37 942.400000

| dctvenit [Fe ] || Bangf5Enion -]

T4& Rx Channel Select Filter Calibration M=l E3

— Filter Adjustment

. | Start |
Decimal |3‘°1 —

ManualTune

Hex |2:2 #Tau I _l

Binary |n1nnn1n AutaTune |

LCapacitar array Staop |

{pg a4 F3 Cz F1 o Hep |

eady . 110102 S (= .
Fead W 260 17-401-02 , MPL-T |, [g] MMP i

Press Autotune and the optimal values are found.
Press Stop and a new window pops up:

Tune ending

Save walues to phone?

Press Yes and the RX Channel Select Filter Calibration is finished.

RX Calibration (incl. VCXO Calibration)

The "RX calibration” is used to determine gain at different gain-settings for front-end
and Mjoelner and needs to be done in both bands.

RX-calibration requires an external signal generator.

RX-calibration in EGSM850 combines two tunings, VCXO-calibration and AGC-calibra-
tion:

Calibration of GSM1900 band only determines AGC values.

The VCXO-calibration finds out a calibration value for VCXO control, an AFC initial
value and 3 AFC-slope coefficients.
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A value (RF_TEMP), which represents the RF hardware temperature, is determined during
RX Calibration. This temperature value is used by DSP to RSSI reporting in Normal mode
of the phone. It is not visible in the calibration process.

AGC-calibration:

The AGC-calibration finds the gain values of the RX-gain system.

The AGC consists of RF LNA, which can be either on or off (gain difference between on
and off state is nominally 30dB) and BB gain which can be controlled in 6dB steps. This
gives 15 gain steps RSSIO to RSSI14. LNA is off for steps RSSIO to RSSI4.
AGC-calibration measures the gain at gain step RSSI4 and RSSI7. The other gain values
are calculated.

VCXO-calibration:

The VCXO0-calibration ensures the function of an initial synchronization (before location
update is done) when the mobile station is in Normal mode. For an error free initial syn-
chronization, the 26MHz frequency of the VCXO must be accurate enough. Therefore, a
VCXO cal value is written into the RefOSCCAL register of the Mjoelner.

During VCXO-calibration, the VCXO cal value is changed by a DSP-algorithm until a syn-
chronization is possible. This means the VCXO oscillates at 26 MHz with a sufficient min-
imum frequency error.

To further minimize the frequency error, an initial AFC value is determined by the DSP
and written into RefOSCAFC register of the Mjoelner.

Also the DSP algorithm determines 3 AFC slope coefficients Slope C1...3 during VCXO
calibration. One AFC slope value is not sufficient for Mjoelner F3, because the AFC slope
is non-linear in this chip.

EGSM
Set operating mode to local mode
Select Maintenance Alt-M
Tuning T
RX Calibration C
Wait until the RX Calibration window pops up.
Select Band GSM 850
Autom.- 60
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The setup should now look like this:

% Phoenix M[=] E3

File Edit “iew Product Flazhing Maintenance Toolz D Window Help

J = J EDnnectiuns:lEDM j Settings... |

J DOperating mode: IL::u:aI j Bead | [T Change with Reset

J Sakarn. - |5|:| dbrn st Man. - |5|:| dbrn Zhd Man. - |35 dbm J Band:IGSM 900 vI

% R Calibration

[Ealitrate

Ex
Help |

Calibration mode
™ Atomatic
= tanual

Presz Start buttan

Feady | W20 110102 NPL (o) NMP. 7

Select Automatic, press Start and a new window pops up:

Start parameter:

]
" Default
 Curment Cancel |
) Facton setings
P settings

Select PM settings, press OK and the window closes.

Now it is possible to press the calibrate button in the RX Calibration window.
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Press Calibrate and a window pops up:

Cahbration with band EGSMI00 |

- Initialize zignal generator, zet power level to
-G0dE
and frequency to

942 46771 0mMHz

Connect an external signal generator to the RF connector of the phone and set the gen-

erator as told in the window, taking care for external cable losses.

Press OK and the window closes.

A typical result will look like this:

T& Phoenix

File Edit “iew Product Flashing Maintenance Tool: BD Window
Help

LConhections: i FEUS j Setftings... |

Operating made: ILocaI I Read | [T Change with Feset
Autarn, - I dbm st Man. I dbm  2nd Man. I dbrn

Band: IGSM a0n l

T4 Rx Calibration

IO
J
J
|
J

Itemn Walue |
A0 cal 588.000000

Afc value 3056.000000 Lalibrate |

Slope C1 2721.000000

Slope C2 -455. 000000 Help
Slope C3 1.000000

Fizzill E2.093750 i~ Calibration mode-
Fissil £8.093750 | & Automatic
Rasi2 74.033750 | ~

Rssid g00ga7so | | C Manual
Rizzid 86033750

Rzl 96 015625

Rizzif 102015625

Riasi? 108015625

Rizsid 114.015625

Fizzid 120015625

Rzzil0 126015625

Fiasill 132015625

Rzsil2 138015625

Fizsil3 144015625

Rizsil4 150015625

Feady | 7

Press Stop in the RX Calibration window and a new window pops up:

Calibration ending [ =]

D' wow want to zave values to phone?

Copyright (2003 Nokia Corporation
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Press Yes and the EGSM RX Calibration is finished.

GSM1900 (PCS)
Set operating mode to local mode

Select Maintenance Alt-M
Tuning T
RX Calibration C
Wait until the RX Calibration window pops up.
Select Band GSM 1900
Autom. -60
1t Man. -50
2" Man. -85

The setup should now look like this:

% Phoenix I[=] E3

File  Edit “iew Product Flashing Maintenance Tool: BD  window Help

J O = = J Ennnectinns:lEDM j Settings... |
J Operating mode: IL::u:aI j Fead | [~ Change with Feset
J Autarm, - |5|:| dbrn 13t Man. - |5|:| dbrn 2nd Man. - |35 dbri

% RAx Calibration

| Band[GSM 1800 =]

[Ealitrate

Help

Calibration mode
A tomatic
" Manual

Preszz Start button

Select Automatic, press Start and a new window pops up:

Start parameter: E

K

= Default

£ Curment Cancel |

£ Factany settings

Select PM settings, press OK and the window closes.

Now it is possible to press the calibrate button in the RX Calibration window.

Issue:1 07/2003 Copyright (2003 Nokia Corporation Page 3-23
Company Confidential



NHM-10 Company Confidential NOKIA
3 - Service Software CCS Technical Documentation

Press Calibrate and a window pops up:

Calibration with band GSM1900 |

- Initialize zignal generatar, set power level to
-E0dEm
and frequency o

1960.057 71 0MHz

Connect an external signal generator to the RF connector of the phone and set the gen-
erator as told in the window, taking care for external cable losses.

Press OK and the window closes.

A typical result will look like this:

4 Phoenix
File Edit “iew Product Flashing Maintenance Toolz BD window
Help

LConnections: i FEBUS j Seftingz... |

D perating mode: ILocaI l Read | ™ Change with Reset
Autom. - I dbm 1st Man. I dbm  Znd Man. I dbm

Band: IGSM 1300 'l

|0
J
J
|
J

Item Walue |
Rzsil £0.8959375

Rzl BE.859375 Lalibrate |
Rssi2 72859375
Rssi3 78.853375 Help |

Rssid 84.859375
Rszif 91.812500 i~ Calibration mode 1
Rssif 57812500 | & Agtomatic |
Rissi? 103812500 | & Maral |
Rssid 103812500 | | o Mamwal
Rssid 115812500
Rssill 121812500
Rssill 127812500
Fissil2 133.812500
Rissil3 139.812500
Rssild 145.612500

Press Stop in the RX Calibration window and a new window pops up:

Calibration ending

Do pou want to zave values to phone?

Press Yes and the GSM 1900 RX Calibration is finished.
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RX AGC limits

The Rx calibration is only valid if it is within certain limits.
For the most recent limits see NHM-10 Production Testing Requirements,
If calibration is not within limits, there is a fault in the RX chain.

Below the values for RSSI4 and RSSI7 are given:

RSSI4:
band min typ max
EGSM850 81 86 91
GSM1900 79 85 89
RSSI7:
band min typ max
EGSM850 103 108 113
GSM1900 100 104 110

RX Band Filter Response Compensation

EGSM850 (EGSM)
Set operating mode to local mode

Select Maintenance Alt-M
Tuning T
RF Controls F

Wait until the RF Controls window pops up

Select Band GSM 850
Select Maintenance Alt-M
Tuning T
RX Band Filter Response Compensation B

A window pops up:

Tune start

Load Y aluesz from phone PR 7

Select Yes and the RX Band Filter Response Compensation window pops up.
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The setup should now look like this:

% Phoenix M=l

File Edit ‘iew Product Flashing Maintenance Tool: BD  window Help

J O = n |J Qonnections:lCDM j Settings... I |J Operating mode: ILoca| vl Bead | ™ Change with Reset
| Edge N | Bang[GSM o0 =]

% RF Controls % Rx Band Filter Response Compensation [_ (O] x]

Band:IGSM 300 j' [t Siaral Leyel I'BU j Start, Read from PM area |
Active Unit: IF!x 'l
" ' Measzured Level - i |
Operation Mode:IBurst j C Input Frequency [MHz] Difference (dB) felatua! Mg
965 923.26771 -2.683 et Teri |
Fix/T# Channel: |37 942,400000 75 925.26771 -1.250 =
987 927 66771 0734
Manitar EhanneI:IS? 942400000 1009 932 06771 -0.859 Stop, wWiite b Bl area |
37 942 46771 0172
AGC: |14: FEG_OM +DTOS_OM +BB_4 90 953.06771 -0.609
114 957.86771 0734 Help |
AFC: 3080 124 959 86771 -0.984 ; )
136 962 26771 4453 Signal Generator Setting:
Input Slgnal Level
+ cable attenuation.
T able to Clipboard:
Select Letf Top of table
[with text 'Thannel’].
Press left mouse
Select Input Signal Level -60dBm

Manual Tuning
Press Manual tuning and a window pops up:

Manual Tuning E

Set 92326771 MHz, level -60 dBm
+ cable attenwation, to RF generatar.
Presz OFK. [Press ESC to interrupt sequence. |

Cancel

d

Connect an external signal generator to the RF connector of the phone and set the gen-
erator as told in the window.

Press OK and a new window pops up:

M anual Tuning Ei

Set 925 26771 MHz. level -60 dBm
+ cable attenuation, to BF generator.
Presz OF. [Presz ESC to interrupt segquence. |

H Cancel |

Set the generator as told in the window.

Press OK and a new window pops up. Repeat this sequence 9 times until all channels are
done.
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Press Stop, Write to PM Area (In the RX Band Filter Response Compensation window) and
a window pops up:

End Tuning

Save YWalues ta phone P

Press Yes and the EGSM RX Band Filter Response Compensation is finished.

GSM1900 (PCS)
Set operating mode to local mode

Select Maintenance Alt-M
Tuning T
RF Controls F

Wait until the RF Controls window pops up

Select Band GSM 1900
Select Maintenance Alt-M
Tuning T
RX Band Filter Response Compensation B

A window pops up:
Tune start

Load/alues from phone P77

Select Yes and the RX Band Filter Response Compensation window pops up.
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The setup should now look like this:

‘s Phoenix =l &3

File Edit “iew Product Flashing Maintenance Tool: BD  Window Help

J O = n |J Qonnections:lEDM j Settings... I |J Operating mode: ILoca| vl Bead I [ Change with Reset
| Edge s | Banc[GSH 1900 <]

& RF Controls /% Rx Band Filter Response Compensation [_Tolx=]
Band:IGSM 1300 j' Input Signal Level j Sitart, Fead fram B aea |
Active Unit [z~ 7 T

- Manual Tuni |
Channel Input Frequency [MHz] easured Leve = g
Operation Mode: I Burst 'l Difference (dB)
496 1927 06771 -0.344 Auto Tunin |
Rx/Tx Channel: |EE1 1960.000000 512 193026771 0.000 — l
537 193526771 0125
Manitar Channel: | 661 1960.000000 h86 194506771 0.375 Stop, Wiite to PM area |
661 196006771 0125
AGC: |14: FEG_OM +DTOS_OM +BE_4 736 197506771 0125
794 198666771 014 Help |
AFC: IBDSD 810 198986771 -0.422 . )
815 1994 86771 Nikiord Signal Generator Setting:
Input Slgnal Lewel
+ cable attenuation.
Table to Clipboard:
Select Letf Top of table
[with text 'Channel’).
Press left mouse
Select Input Signal Level -60dBm

Manual Tuning
Press Manual tuning and a window pops up:

Manual Tuning E

Set 1927 06771 MHz, level -60 dBm
+ cable attenuation, to RF generator.
Prezs OFK. [Prezs ESC ta intermupt zequence. |

Cancel |

Connect an external signal generator to the RF connector of the phone and set the gen-
erator as told in the window.

Press OK and a new window pops up:

Manual Tuning E

Set 193026771 MHz, level -60 dBm
+ cable attenwation, to RF generator.
Presz OF. [Presz ESC to interrupt sequence. ]

; Carcel |

Set the generator as told in the window.

Press OK and a new window pops up. Repeat this sequense 9 times until all channels are
done.

Page 3-28 Copyright (2003 Nokia Corporation Issue:1 07/2003
Company Confidential



NOKIA Company Confidential NHM-10
CCS Technical Documentation 3 - Service Software

Press Stop, Write to PM Area (In the RX Band Filter Response Compensation window) and
a window pops up:

End Tuning

Save Values to phone P47

Press Yes and the EGSM RX Band Filter Response Compensation is finished.

TX 1/Q Tuning

This tuning must be done in both bands.

EGSM (EGSM850)

Caution: In case you use a spectrum analyser make sure that the external attenua-
tion (20 - 30dB) between phone and spectrum analyser is high enough
that the input of the analyser can't be destroyed. Adjust the reference
level offset according to the insertion loss from the phone to the spectrum
analyser .

PC/Phone operation:
Set operating mode to local mode

Select Maintenance Alt-M
Tuning T
TX'1Q Tuning I

Wait until the TX IQ Tuning window pops up.

Select Maintenance Alt-M
Tuning T
RF Controls F

Wait until the RF Controls window pops up.

Connect a Spectrum Analyzer or GSM tester with the option *Narrow Spectrum' to the
RF connector of the phone.

If a spectrum analyzer is used then use the following settings.

EGSM/EGSM850
Center Frequency 897.4 MHz
Frequency Span 300 kHz
Resolution Bandwidth 3kHz
Video Bandwidth 3kHz
Sweep Time 3 sec.
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EGSM/EGSM850
Sweep Type Clear/Write
Detector Type Max Peak
Reference level 35 dBm
Marker 1 897.33229 MHz
Marker 2 897.4 MHz
Marker 3 897.46771 MHz

Select in the RF Controls Window:

Select Band GSM 850
Active Unit  TX
Operation Mode Burst
RX/TX Channel 37

TX PA Mode Free
TX Data Type All1

Select in the TX 1Q Tuning Window:

Select "Load from Product”
“Save to Product”

Press Start
Select again in the RF Controls Window:
Select TX Power Level 5
The setup should now look like this:
% Phocnix I =] 3

File Edt Yiew Product Flashing Maintenance Tools RD ‘Window Help

J 0= n H'E_peratingmode: ILucaI Yl_ Read | I~ Change with Resst H Connection IFBUS COM1 ¥|  Seftings.. | Eegﬁisﬂaﬁon |

| EdgeNia H e | H.Uper_ationmdg:lawst v] | AwTuCharel 57 97 400000 |J TuDataType: |41 <1 || epatode: [Free =]
“k: RF Controls e ! T. u] l(_l ‘% Tx 18 Tuning H=1E3
Bant[Coi 00 ] THPA Mode: [Free =], 11 DEfsei [ 000 Eiei
; - A% 100% -
Bctive Unit: |Te = TwPowerLevel |5 = L ]
'_Efp_e_ral_ion‘MD:de:IBursl ‘.'I T Data Type:. IAIH "l '
R/TuChannet [37 297.400000 T DC cifset: | 0.800
o) e 100% 100% [/ Load from Product.
Maritor Channel| 37 S AN L B A O S R S O R O S R o
- . | J ¥ Save to Product
AGC: |14 FEG_ON + DTOS_ON + BE_42=VGan. 72 7]
oFC [308 Help :
4| Ampltude diference: | 0.0

60

r

Phase difference | 88.0

Z70°
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The Spectrum Analyzer now shows a plot like this:

Marker 1 [ T1] RBW 3 kHz RF Att 30 dB
% Ref Lvl 33.35 dBm VBW 3 kHz
35 dBm 897. 33229000 MHz SWI 3 s Uni t dBm
35 1

a0 27.5 B O f set ﬂ Yi|[T1] 33. 35 dBn
897. 33229000 Mz

/\ Vol[[T1] -6.76 dBn|

20 e e
V3| T1] -1Q. 74 dBn|

897. 46771000 MHz

| AR
| MMW W\Mm | 3

20

Mr] WWW%W M%

-50

- 60

- 65

Center 897.4 Mz 30 kHz/ Span 300 kHz

Dat e: 14. JAN. 2002 13:11:55

The purpose of this tuning is to tune the carrier signal and the +67kHz signal to a mini-
mum level (Marker 2 and 3).

Use the variables 'TX | DC offset' and 'TX Q DC offset' to adjust the carrier signal to a
minimum level (Marker 2).

After tuning to the minimum the level difference between the peak levels at marker 1
and 2 must exceed 40dB.

Tuning is possible by using arrow keys on the keyboard. Pushing the sliders by using the
mouse is less sensitive but even possible.
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The Spectrum Analyzer now shows a plot like this:

NVarker 1 [T1] RBW 3 kHz RF Att 30 dB
@ Ref Lvl 33. 65 dBm VBW 3 kHz
35 dBm 8197. 33229000 MHz SWIr 3s Uni t dBm
35

o 27.5 UB Off set ]\ v [T 3365 denl
897. 33229000 MHz

/\ V2|[T1] -19. 54 dBn|

20, QLT 400008001
V3|[T1] -1Q. 79 dBn|

897. 46771/000 MHz

T T V7N
) :
RV Y. |
. M“”hlr{ L / \

40 M‘W‘W\uf\

A
g

—]

e

hl/\.
0 oy

- 50
- 60|
- 65
Center 897.4 MHz 30 kHz/ Span 300 kHz
Dat e: 14. JAN. 2002 13: 20: 36
Use the variables '‘Amplitude difference’ and 'Phase difference’ to adjust the +67kHz sig-
nal to a minimum level (Marker 3). After tuning to the minimum the level difference
between the peak levels at marker 1 and 3 must exceed 40dB. Tuning is possible by using
arrow keys on the keyboard. Pushing the sliders by using the mouse is less sensitive but
even possible.
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The Spectrum Analyzer now shows a plot like this:

Mar ker 1 [ T1] RBW 3 kHz RF Att 30 dB
% Ref Lvl 33. 40 dBm VBW 3 kHz
35 dBm 897. 33229000 Mz SWI 3 s Uni t dBm
35 1

27.5 dB O f set A val|[T1] 34. 40 dBn

30 897. 33229000 MHz
/\ Vol[T1] -2Q. 35 dBn

20 897 40000000 VH
V3|[T1] -27.60 dBn

897. 46771000 MHz

| IR

-10 “V\M‘
-20 v

-3oh \;I)l L

-40 N U\”ﬂ’w ww\j

-50
60
-65
Center 897.4 MHz 30 kHz/ Span 300 kHz
Dat e: 14. JAN. 2002 13:23:02
Select again in the RF Controls Window:
Select “Save to Product”
Press Stop and the values are stored in the phone.
The EGSM TX 1Q Tuning is now finished.
Note: The optimal values for "TX | and Q Offset" and "Amplitude and Phase Difference"
vary from phone to phone.
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GSM1900 (PCS)

Caution: In case you use a spectrum analyser make sure that the external attenua-
tion (20 - 30dB) between phone and spectrum analyser is high enough
that the input of the analyser can't be destroyed. Adjust the reference

level offset according to the insertion loss from the phone to the spectrum

analyser .

PC/Phone operation:

Set operating mode to local mode

Select

Maintenance

Tuning

TX'1Q Tuning

Wait until the TX IQ Tuning window pops up.

Select

Maintenance

Tuning

RF Controls

Wait until the RF Controls window pops up.

Alt-M

Alt-M

Connect a Spectrum Analyzer or GSM tester with the option *Narrow Spectrum' to the
RF connector of the phone.

If a spectrum analyzer is used then use the following settings.

Select in the RF Controls Window:

Select

Page 3-34

GSM1900
Center Frequency 1880MHz
Frequency Span 300 kHz
Resolution Bandwidth 3 kHz
Video Bandwidth 3 kHz
Sweep Time 3 sek.
Sweep Type Clear/Write
Detector Type Max Peak
Reference level 35dBm
Marker 1 1879.93229 MHz
Marker 2 1880 MHz
Marker 3 1880.06771 MHz

Band

GSM 1900

Copyright (2003 Nokia Corporation
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Active UnitTX

Operation Mode Burst
RX/TX Channel 661
TX PA Mode Free
TX Data Type Alln

Select in the TX 1Q Tuning Window:

Select “Load from Product”
“Save to Product”

Press Start

Select again in the RF Controls Window:
Select TX Power Level O

The setup should now look like this:

‘& Phoenix M=l E3
Ede Ejﬂ Wiew Product F\Qshlng Mamenénce. f_i:ol&’ BD Window Help

H | Eperahngmode Local I Read | I™ Change with Reset H Djrmectlm IFEUS COm1 l Settings.. Heglsijatrnn |
J Edge‘N&’A H BandIGSM 1900 » | UuejallanMnde'IBursl “ thf’Tx Ehann&\ IEE'I 1880.000000 H TnDataTymé, IA\H I

Tx P4 Mode: |Free ™

1 y
“& RF Controls I Il 3 || % T% 19 Tuning ] =lOlx|
Bandt [GEM 1900 =] TePAMade [Free 7] et citsct (S RI0 Sit
; 100% 0% ;
botive Uit Iﬁi TuPowerLevel [0 =] IJ Stop
BperatlonMod.c 'Y T Data T“gpe:: IA\H X] - I Help

T3 OC offset: | 0,600

Hfﬁa"[‘éc_ﬁhﬁnm_a],_ g6l Wag_u.jnnqqan

= A00% 100% [ Loadfrom Product

onitor Channeb[B8T | {EB0A0000 e
- I J p'Sg_ye to Product
ABEC: |14 FEGLON +DT05_0N +BB_42=VGan_72 | =]
A ﬂl :Al:‘nph_luﬂe difference: | 0.2 :

I R |

PBhase diference:| §1.0

270" 15307

Ready. [Gemin [No Product ] m
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The Spectrum Analyzer now shows a plot like this:

NMar ker 3 [ T1] RBW 3 kHz RF Att 30 dB
Ref Lvl -12.20 dBm VBW 3 kHz
35 dBm 1. 88006771 GHz SWI 3 s Uni t dBm
3!:
%0 27.5 dB O f set . v3|[T1] -14. 20 dBn
1.88006771 GHz
Vi|[T1] 27.81 dBn
20 187993229 CH
V2l T1] 4.13 dBn
1. 88000000 GHz
10

S | |

_40 ol Aﬂl
i

-50
60
-65
Center 1.88 GH 30 kHz/ Span 300 kHz
Dat e: 15. JAN. 2002 10:53: 47
The purpose of this tuning is to tune the carrier signal and the +67kHz signal to a mini-
mum level (Marker 2 and 3).
Use the variables 'TX | DC offset' and 'TX Q DC offset' to adjust the carrier signal to a
minimum level (Marker 2).
After tuning to the minimum the level difference between the peak levels at marker 1
and 2 must exceed 40dB.
Tuning is possible by using arrow keys on the keyboard. Pushing the sliders by using the
mouse is less sensitive but even possible.
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The Spectrum Analyzer now shows a plot like this:

Mar ker 3 [ T1] RBW 3 kHz RF Att 30 dB
Ref Lvl -15. 03 dBm VBW 3 kHz
35 dBm 1. 88006771 GHz SWI 3 s Uni t dBm
3!:
27.5 dB O f set v3|[T1] -14. 03 dBn
30
1.88006771 GHz
Vi|[T1] 25. 16 dBn
20 187993229 GH
V2l T1] -23.51 dBn
1. 88000000 GHz
10

T 0
:40 W Mﬁm.“h.

-50
- 60
-65
Center 1.88 GH 30 kHz/ Span 300 kHz
Dat e: 15. JAN. 2002 10:57: 06
Use the variables ‘Amplitude difference’ and Phase difference’ to adjust the +67KHz sig-
nal to a minimum level (Marker 3). After tuning to the minimum the level difference
between the peak levels at marker 1 and 3 must exceed 40dB, Tuning is possible by using
arrow keys on the keyboard. Pushing the sliders by using the mouse is less sensitive but
even possible’
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The Spectrum Analyzer now shows a plot like this:

Mar ker 3 [ T1] RBW 3 kHz RF Att 30 dB
Ref Lvl -27.22 dBm VBW 3 kHz
35 dBm 1. 88006771 GHz SWI 3 s Uni t dBm
3!:
27.5 dB O f set v3|[T1] -271.22 dBn
30
1.88006771 GHz
Vi|[T1] 25. 76 dBn
20 187993229 GH
V2l T1] -27.30 dBn
1. 88000000 GHz
10

) g

-50
60
- 65
Center 1.88 GH 30 kHz/ Span 300 kHz
Dat e: 15. JAN. 2002 10: 58: 09

Select ‘Save to Product'
Press Stop in the TX 1Q Tuning Window and the values are stored in the phone.
The GSM1900 TX 1Q Tuning is now finished.

Note: The optimal values for “TX | and Q Offset” and "Amplitude and Phase Difference"” vary
from phone to phone.

TX Power tuning
This tuning must be done in both bands.

Note: TX Power tuning must be done with a peak power meter, e.g. Anritsu model ML2408A
with Anritsu Peak Power Sensor MA2442A and a suitable attenuator.
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The use of power meter in GSM testers is likely to cause larger error than the use of a
dedicated power meter and might cause the phone to be non-compliant with GSM spec-
ifications.

EGSM (EGSM850)
Set operating mode to local mode

Select Maintenance Tuning TX Power Level Tuning
Wait until the TX Power Level Tuning window pops up.
Connect a calibrated powermeter to the RF connector of the phone.

Select Band GSM 850
Active Unit >

Press Start and a window pops up:

Start Tx Power Level Tuning |

Load Fraorm:

IF'ermanent memany LI Cancel |
Help |

Select Permanent memory, press OK and the window closes.
Select TX Data Type Random

The setup should now look like this:

4 Phosni M
e Edt isw Product Flashing Msitensnce Tooks BD window Help

ODEH “ Connections: [FEUS - Setings. H Operating mode: [Local +| Bead | I Charge vith Reset H TuPower Level 13 =

TPt bode: [Figh =] || TData Tupe: [ai7 - | are [z || sctveur: [T =

4 Tx Power Level Tuning I [=] B

Start |

Bandt[asni a0 -]
Edge:|0ff =
Tx P Mode: [Hioh =

Calculste caficients |

Zer DAC:
Help
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Select TX PA Mode High
Tune Base level to =27 dBm.

Adjust DAC Values for Power Level 5 (32 dBm), 15 (13 dBm) and 19 (5 dBm) according to
Target values. The Power levels may differ from Phoenix mentioned target power levels.

Press calculate, check if all levels match the target values, correct if necessary.
Select TX PA Mode Low

Adjust DAC Values for Power Level 7, 15 and 19 according to Target values.
Press calculate, check if all levels match the target values, correct if necessary.

Press Stop and a window pops up:

Stop Tx Power Level Tuning

Do yaou want to stop tuning?

Prezzing ez wil stop the tuning and zave the values
to zelected destinations.
Prezzing Mo will continue tuning without saving.

¥ Save values to Phone Permanent Memmony

Mo
™ Save values to PC Help |

Select ‘Save values to Phone Permanent Memory'
Press Yes and the EGSM TX Power Level Tuning is finished.

GSM1900 (PCS)
Set operating mode to local mode

Select Maintenance Tuning TX Power Level Tuning
Wait until the TX Power Level Tuning window pops up.
Connect a calibrated powermeter to the RF connector of the phone.

Select Band GSM 1900
Active Unit X

Press Start and a window pops up:

Stant Tx Power Level Tuning

Load From:

IPermanentmemnry j Cancel |
Help |
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Select Permanent memory, press OK and the window closes.
Select TX Data Type Random

The setup should now look like this:

% Phoenix = (A]x]

Fle Edit View Product Flashing Maintenance Tooks AD window Help

J DEH H Connections: [FBUS - Settings H Dperating mode: |Lacal =] Read | I Charge wih Reset “ TwPower Level 5 =
| Tepaode [ =] || Txata Tpe: a1 - | arc: [z ||| actveunt: [T =

% Tx Pawer Level Tuning [0l x]

St
Stop

Band [ 1900 -]
Edge [0~
TxPA Mode: [High =

Caloulate caeficients |

Zem DAC:
Help

Select TX PA Mode High
Tune Base level to =27 dBm.

Adjust DAC Values for Power Level 0 (30 dBm), 11 (8.2 dBm) and 15 (1 dBm). The Power
levels may differ from in Phoenix mentioned target power levels.

Press calculate, check if all levels match the target values, correct if necessary.

Press Stop and a window pops up:

Stop Tx Power Level Tuning |

Do you want to stop tuning?

Prezzing r'es will gtop the tuning and save the values
to zelected destinationz.

Prezzing Mo will continue tuning without zaving.
v Save walues to Phone Pemanent Memony

Mo
[T Save values to PC Help |

Select 'Save values to Phone Permanent Memory'

Press Yes and the GSM1900 TX Power Level Tuning is finished.
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